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1. PURPOSE 

 
Uploading stamping request in bulk for share transfer documents enables 
customers to submit stamping requests through the e-Stamping service of the 
Inland Revenue Department more quickly and conveniently. With it, you can 
arrange stamping of share transfer document anytime and anywhere you want. 
You can save time and cost as you do not need to arrange for conventional 
stamping at the Stamp Office. You can arrange stamping for up to a maximum 
of 5,000 share transfer instruments at one time, and only one payment is required. 

 
This user guide provides detailed guidance and step by step procedures on how to 
prepare a data file for uploading and submitting the stamping application through 
the e-Stamping service. 

 
This document will be updated when there are changes. You are reminded to 
check the updated version at the e-Stamping service menu. 
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2. GENERAL INFORMATION 

 
The bulk upload service is applicable to share transfer document in relation to 
listed shares and unlisted shares. Please read the following in relation to the 
scope of the bulk upload services: 

 
1) All transactions to be uploaded in the same data file should bear the same 

execution date. 
2) All transactions to be uploaded in the same data file shall be executed either 

in Hong Kong, or outside Hong Kong. 
3) Bulk stamping application for duplicates of documents will not be accepted. 
4) Bulk stamping application for transfer of shares of unlisted company which 

owns subsidiaries, landed properties, or right to acquire landed properties will 
not be accepted. 

5) The bulk upload service is applicable to in-time applications only. 
6) You can submit not more than 5,000 instruments for stamping in the same 

data file. 
7) All transactions successfully uploaded in the same data file will be treated as 

a single application. Only one payment notice will be generated. 
8) If the consideration or value of share(s) is in foreign currency, please convert 

the amount to their equivalent in Hong Kong dollars. 
 

In order to use the bulk upload service, you have to prepare an upload file in 
XML format. You can easily prepare the upload file in XML format by either 
one of the following two ways: 

 
 Make use of the readily available Upload Data Preparation Template. For 

details, please refer to sections 3 and 4. 
 

 Make use of your own custom-developed applications to prepare XML file 
directly based on the pre-defined Data Specification in Document Type 
Definition (DTD).  For details, please refer to section 5 and Appendix A. 
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3. USING UPLOAD TEMPLATE 

3.1 CONFIGURATION SETTING 
 

In order to prepare the upload XML file using the Upload Data Preparation 
Template, the following has to be installed. Such installation steps are required 
once only. 

 
 Software for viewing document in PDF format; 
 OpenOffice version 4.x which can be downloaded at the website 

https://www.openoffice.org; 
 Java Runtime Environment (JRE) software (version 1.8.0 or above) which 

supports runtime environment for OpenOffice can be downloaded at the 
website https://java.sun.com;  

 Upload Data Preparation Template and XML Filter Package which can be 
downloaded by following below steps: 
 Go to the Inland Revenue Department (IRD) website:  

https://www.ird.gov.hk. Click the “e-Stamping” icon to proceed to the 
e-Stamping service menu. 

 

 
 

 

https://www.openoffice.org/
https://java.sun.com/
https://www.ird.gov.hk/
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 In the e-Stamping service menu, locate the section “Upload Stamping 
Applications in Bulk”, click “notes” in “Share (Please refer to the 
notes)”. 
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 Below pop-up window will be prompted. Download the Upload Data 
Preparation Template and the XML filter package applicable to your 
stamping requests. 
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After the above installation, it is required to enable the Java option of OpenOffice 
as follows: 

 
Launch OpenOffice and click “Tools” -> “Options”. 

 

 
 

Select “Java”, click “Add” to select the installed JRE (version 1.8.0 or above) 
from pop-up window. 
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Select the correct JRE version and click “OK”.  For OpenOffice 32-bit Windows version, 
please select the 32-bit JRE version. 

 

  
 

BULK UPLOAD STAMPING REQUEST USER GUIDE (SHARE TRANSFER) 
USING UPLOAD TEMPLATE 

 

 
 

 



Page 10 

BULK UPLOAD STAMPING REQUEST USER GUIDE (SHARE TRANSFER) 
USING UPLOAD TEMPLATE 

 

 

To install the XML Filter Package, click “Tools” -> “XML Filter Settings”. The 
following pop-up menu will be shown. 

 
Click “Open Package”, locate the applicable XML Filter Package (e.g. 2A - 
Stamping of Unlisted Share Transfer (Sale and Purchase).jar), and click “Open”. 

 

 
 

Upon successful installation, the following message will be shown. 
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3.2 PREPARE UPLOAD FILE 

 
3.2.1 Inputting Data in the Upload Data Preparation Template 

 
You can use OpenOffice to input transaction data into the Upload Data 
Preparation Template. You may input records for up to 5,000 
stamping instruments in one template. Records must be input row by 
row in the worksheet “Stamping_details”. 

 
If there are common details (such as the transferor details and 
transferee details) for records within the same upload file, it is more 
convenient to use the worksheet “Common_details” to input such data. 

 
To do so, select the worksheet “Common_details”. Input common data 
in the row “COMMON DATA”. For “Add numbers of rows”, input 
the numbers of rows that you would like the common data to  be 
applied to.  Click “Copy data to Stamping Details Page”. 
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The content in the row “COMMON DATA” of the worksheet 
“Common_details” will be copied to the worksheet “Stamping_details”. 
You can repeat above steps to append more rows as needed. 

 

  
 



Page 13 

BULK UPLOAD STAMPING REQUEST USER GUIDE (SHARE TRANSFER) 
USING UPLOAD TEMPLATE 

 

 

3.2.2 Conversion to XML File 
 

e-Stamping only accepts XML format. Therefore, you need to convert 
the file into XML format. Use OpenOffice to open the file that you 
have prepared in section 3.2.1 and select the worksheet 
“Stamping_details”. Click “File” -> “Save As”. Enter a file name at 
“File name” and select the applicable XML file type at “Save as 
type”. 

 

 
 

Below screen will be prompted. Click “Keep Current Format” to 
proceed. A new file in “.xml” extension will be created. This file is to 
be used for uploading and submitting the stamping application. 
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3.2.3 Troubleshooting 
 

Q1.    What should I do if “Write Error” is shown when I save the file 
as XML format? 

 
A1. Check the version of OpenOffice installed. It should be version 

4.x. If the OpenOffice version matches with the 
recommendation, the installed XML Filter Package may have 
been corrupted. Please reinstall the XML Filter Package. In 
this regard, please perform the removal action according to the 
following 2 steps before you perform the re-installation” 

 
 Click “Tools” -> “XML Filter Settings”. Highlight the 

installed XML Filter and click “Edit”. A window will be 
popped up showing details of the filter. Click at the 
“Transformation” tab, record the file path for the 
“DTD” / “XSLT for export” / “XSLT for import”, then 
click “Cancel” to return to “XML Filter Settings” dialog 
box, finally click “Delete” button to remove the filter. 

 Remove the 3 recorded files (in above step) physically. 
 

Q2. What should I do if “The selected JRE is defective” is shown 
when I save the file as XML format? 

 
A2. This problem may be caused by an unacceptable version of JRE 

installed. Check the version of the JRE through to “Tools -> 
option -> OpenOffice -> Java”. The version should be 1.8.0 
or above. 

 

 
 

If the JRE version matches with the recommendation, the 
installed JRE may be corrupted. Please uninstall or delete the 
corrupted JRE and install a new one. 
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4. SUBMITTING STAMPING REQUEST 
 
4.1 GETTING STARTED 

Locate the e-Stamping service menu by clicking the “e-Stamping” icon at IRD 
website (https://www.ird.gov.hk). 

 
 

Click either one of the three links under “Upload Stamping Applications in 
Bulk” applicable to your stamping request. 

 

 
 

 
 

https://www.ird.gov.hk/
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Select the authentication method and enter details, then click “Submit”. 

 
 

For stamping of share transfer document in relation to listed or unlisted share, 
proceed to section 4.2. 
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4.2 LISTED/UNLISTED SHARE TRANSFER 

 
Welcome Page 

 

After successful authentication, you will be directed to below Welcome Page. 
Click “Continue”. 
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Step 1: Read Important Notes 
 

Read the important notes carefully.  Click “Begin Application”. 
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Step 2: Enter Details and Upload Data File 
 

Enter the applicant particulars and upload the data file.  Click “Continue”. 
 

The file size of the XML file must not exceed 2.5 MB.  If the file size exceeds 
2.5 MB, please zip the XML file by “Deflate” compression method and upload 
the ZIP file. 

 
On average, the XML file with file size 2.5 MB can store data for about 300 
records. This is only an approximate figure for your reference, the actual file size 
depends on the data inputted into the file. 
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It may take some time to process the upload file and to validate the records in the 
upload file. A progress page will be displayed showing the upload progress. If 
there is no response after a prolonged period of time, it may be because the server 
is busy.  Please exit the application and try again later. 

 
The uploading process will be completed after validating all the records in the 
upload file. If there is rejected record in the upload file, below screen will be 
shown. Click “Rejection reason(s)” for details. 

 

 
 

A pop-up window with the relevant error message(s) will be displayed.  Exit the 
application, rectify all the errors and then upload again. 
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If all the records can pass the validation checking, below screen will be shown. 
Click “Continue”. 
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Step 3: Sign and Submit 
 

Check the particulars on this page carefully. Click “Particulars of the Shares 
under Transfer and Stamp Duty Payable” in Part B to check the correctness of 
the transaction details. The amount of stamp duty payable for each transaction 
will also be shown. 

 
Select the payment option and click “Sign and Submit”. If online payment 
method is selected, proceed to Step 4. If offline payment method is selected, 
proceed to Step 5(b). 
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Step 4: Make Payment 
 

Click “Pay Now” to proceed with online payment. 

 
 

Select the online payment method and click “Pay”.  After successful payment, 
you will be directed to Step 5(a). 
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Step 5(a): Acknowledgement with online payment selected 
 

After successful online payment, you will be directed to below acknowledgement 
page, indicating that your application has been successfully submitted to the 
Inland Revenue Department. 

 
Click “Download Stamp Certificate Control List” to download the stamp 
certificate control list. Click “Print” or “Save” to print or save this 
acknowledgement page for future reference. 
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Step 5(b): Acknowledgement with offline payment selected 
 

If offline payment method is selected, you will be directed to below 
acknowledgement page, indicating that your application is pended until you have 
settled the payment. 

 
For payment purpose, click “Download Payment Notice” to download and print 
the payment notice. For reference purpose, click “Instrument Reference 
Number” to download the Instrument Reference Number list. Click “Print” or 
“Save” to print or save this acknowledgement page for future reference and 
retrieval of stamp certificate control list (section 4.3). 

 
 

Please arrange payment on or before the due date as set out in the payment 
notice. You can find details of the payment method at the website  
https://www.ird.gov.hk/eng/tax/pay_pme.htm. 

 

After full and in time settlement of payment, the stamp certificate control list will 
be available online for your retrieval within 2 working days after payment 
settlement. For details of how to retrieve the stamp certificate control list, 
proceed to section 4.3. 

 

 
 

https://www.ird.gov.hk/eng/tax/pay_pme.htm
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4.3 STAMP CERTIFICATE CONTROL LIST RETRIEVAL 

For retrieving the stamp certificate control list, please go to the e-Stamping 
service menu.  Click “Print” under “Stamp Certificate Control List”. 
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Welcome Page 
 

After successful authentication, you will be directed to below Welcome Page. 
Click “Continue”. 

 
 

Step 1: Read Important Notes 
 

Read the important notes.  Click “Begin Application”. 
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Step 2: Enter any One Item for Retrieval 
 

Enter either the Charge No. or the Transaction Reference No. of your stamping 
application and click “Submit”. 

 
 

Step 3: Download Stamp Certificate Control List 
 

You will be directed to below screen. Click “Download Stamp Certificate 
Control List” to download the stamp certificate control list. 

 

 
 

 
 



Page 29 

BULK UPLOAD STAMPING REQUEST USER GUIDE (SHARE TRANSFER) 
USING CUSTOM-DEVELOPED APPLICATIONS 

 

 

 
 

 

5. USING CUSTOM-DEVELOPED APPLICATIONS 
 

If your data is stored in a system or a database and from it you can generate an 
XML file with your own custom-developed application, you can generate the 
upload file for submitting the stamping application without using OpenOffice and 
converting the file into XML file type (i.e. you can skip section 3). 

 
The XML file generated by custom-developed application must be in pre-defined 
format as described on the following page. For detailed description of the data 
specification, please refer to Appendix A. 

 
After you have prepared the XML file, you can submit the stamping application 
by following the procedures in section 4. 
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Details of the specification of the upload XML file are shown below: 
 
5.1 LISTED SHARE TRANSFER (SALE AND PURCHASE) 

<!ELEMENT TRANSACTIONS (TRANSACTION*)> 
<!ATTLIST TRANSACTIONS version CDATA '1.0'> 

 
<!-- Field Definitions for TRANSACTIONS Element --> 
<!ELEMENT TRANSACTION (TRANSACTION_NUM, TRANSACTION_NATURE, 
SHARES_NATURE, DOC_IT, DOC_BNOTE, DOC_SNOTE, EXECUTION_DATE, 
EXECUTION_PLACE, NUM_SHARES, CONSIDERATION, AGREEMENT_EXECUTED, 
STOCK_CODE, STOCK_CHIN_NAME, STOCK_ENG_NAME, TRANSFER_PARTY+)> 

 
 

<!-- Field Definitions for TRANSACTION Element --> 
<!ELEMENT TRANSACTION_NUM (#PCDATA)> 
<!ELEMENT TRANSACTION_NATURE (#PCDATA)> 
<!ELEMENT SHARES_NATURE (#PCDATA)> 
<!ELEMENT DOC_IT (#PCDATA)> 
<!ELEMENT DOC_BNOTE (#PCDATA)> 
<!ELEMENT DOC_SNOTE (#PCDATA)> 
<!ELEMENT EXECUTION_DATE (#PCDATA)> 
<!ELEMENT EXECUTION_PLACE (#PCDATA)> 
<!ELEMENT NUM_SHARES (#PCDATA)> 
<!ELEMENT CONSIDERATION (#PCDATA)> 
<!ELEMENT AGREEMENT_EXECUTED (#PCDATA)> 
<!ELEMENT STOCK_CODE (#PCDATA)> 
<!ELEMENT STOCK_CHIN_NAME (#PCDATA)> 
<!ELEMENT STOCK_ENG_NAME (#PCDATA)> 

 
 

<!ELEMENT TRANSFER_PARTY (PARTY_TYPE, SEQ_NO, ENG_NAME_1, ENG_NAME_2, 
ENG_NAME_3, CHIN_NAME, PRN, PASSPORT_NO, BRN, OTHER_COMPANY_NO, 
ENG_CORR_ADDR_1, ENG_CORR_ADDR_2, ENG_CORR_ADDR_3, ENG_CORR_ADDR_4, 
ENG_CORR_ADDR_5 )> 

 
<!ELEMENT PARTY_TYPE (#PCDATA)> 
<!ELEMENT SEQ_NO (#PCDATA)> 
<!ELEMENT ENG_NAME_1 (#PCDATA)> 
<!ELEMENT ENG_NAME_2 (#PCDATA)> 
<!ELEMENT ENG_NAME_3 (#PCDATA)> 
<!ELEMENT CHIN_NAME (#PCDATA)> 
<!ELEMENT PRN (#PCDATA)> 
<!ELEMENT PASSPORT_NO (#PCDATA)> 
<!ELEMENT BRN (#PCDATA)> 
<!ELEMENT OTHER_COMPANY_NO (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_1 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_2 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_3 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_4 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_5 (#PCDATA)> 
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5.2 LISTED SHARE TRANSFER (OTHER THAN SALE AND 
PURCHASE) 

<!ELEMENT TRANSACTIONS (TRANSACTION*)> 
<!ATTLIST TRANSACTIONS version CDATA '1.0'> 

 
<!-- Field Definitions for TRANSACTIONS Element --> 
<!ELEMENT TRANSACTION (TRANSACTION_NUM, TRANSACTION_NATURE, 
SHARES_NATURE, DOC_IT, EXECUTION_DATE, EXECUTION_PLACE, NUM_SHARES,, 
STOCK_CODE, STOCK_CHIN_NAME, STOCK_ENG_NAME, NOMINEE_IND, 
TRANSFER_PARTY+)> 

 
 

<!-- Field Definitions for TRANSACTION Element --> 
<!ELEMENT TRANSACTION_NUM (#PCDATA)> 
<!ELEMENT TRANSACTION_NATURE (#PCDATA)> 
<!ELEMENT SHARES_NATURE (#PCDATA)> 
<!ELEMENT DOC_IT (#PCDATA)> 
<!ELEMENT EXECUTION_DATE (#PCDATA)> 
<!ELEMENT EXECUTION_PLACE (#PCDATA)> 
<!ELEMENT NUM_SHARES (#PCDATA)> 
<!ELEMENT STOCK_CODE (#PCDATA)> 
<!ELEMENT STOCK_CHIN_NAME (#PCDATA)> 
<!ELEMENT STOCK_ENG_NAME (#PCDATA)> 
<!ELEMENT NOMINEE_IND (#PCDATA)> 

 
 

<!ELEMENT TRANSFER_PARTY (PARTY_TYPE, SEQ_NO, ENG_NAME_1, ENG_NAME_2, 
ENG_NAME_3, CHIN_NAME, PRN, PASSPORT_NO, BRN, OTHER_COMPANY_NO, 
ENG_CORR_ADDR_1, ENG_CORR_ADDR_2, ENG_CORR_ADDR_3, ENG_CORR_ADDR_4, 
ENG_CORR_ADDR_5 )> 

 
<!ELEMENT PARTY_TYPE (#PCDATA)> 
<!ELEMENT SEQ_NO (#PCDATA)> 
<!ELEMENT ENG_NAME_1 (#PCDATA)> 
<!ELEMENT ENG_NAME_2 (#PCDATA)> 
<!ELEMENT ENG_NAME_3 (#PCDATA)> 
<!ELEMENT CHIN_NAME (#PCDATA)> 
<!ELEMENT PRN (#PCDATA)> 
<!ELEMENT PASSPORT_NO (#PCDATA)> 
<!ELEMENT BRN (#PCDATA)> 
<!ELEMENT OTHER_COMPANY_NO (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_1 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_2 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_3 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_4 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_5 (#PCDATA)> 
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5.3 LISTED SHARE TRANSFER (CHANGE OF NOMINEE) 

<!ELEMENT TRANSACTIONS (TRANSACTION*)> 
<!ATTLIST TRANSACTIONS version CDATA '1.0'> 

 
<!-- Field Definitions for TRANSACTIONS Element --> 
<!ELEMENT TRANSACTION (TRANSACTION_NUM, TRANSACTION_NATURE, 
SHARES_NATURE, DOC_IT, EXECUTION_DATE, EXECUTION_PLACE, NUM_SHARES, 
STOCK_CODE, STOCK_CHIN_NAME, STOCK_ENG_NAME, NOMINEE_IND, 
TRANSFER_PARTY+)> 

 
 

<!-- Field Definitions for TRANSACTION Element --> 
<!ELEMENT TRANSACTION_NUM (#PCDATA)> 
<!ELEMENT TRANSACTION_NATURE (#PCDATA)> 
<!ELEMENT SHARES_NATURE (#PCDATA)> 
<!ELEMENT DOC_IT (#PCDATA)> 
<!ELEMENT EXECUTION_DATE (#PCDATA)> 
<!ELEMENT EXECUTION_PLACE (#PCDATA)> 
<!ELEMENT NUM_SHARES (#PCDATA)> 
<!ELEMENT STOCK_CODE (#PCDATA)> 
<!ELEMENT STOCK_CHIN_NAME (#PCDATA)> 
<!ELEMENT STOCK_ENG_NAME (#PCDATA)> 
<!ELEMENT NOMINEE_IND (#PCDATA)> 

 
 

<!ELEMENT TRANSFER_PARTY (PARTY_TYPE, SEQ_NO, ENG_NAME_1, ENG_NAME_2, 
ENG_NAME_3, CHIN_NAME, PRN, PASSPORT_NO, BRN, OTHER_COMPANY_NO, 
ENG_CORR_ADDR_1, ENG_CORR_ADDR_2, ENG_CORR_ADDR_3, ENG_CORR_ADDR_4, 
ENG_CORR_ADDR_5 )> 

 
<!ELEMENT PARTY_TYPE (#PCDATA)> 
<!ELEMENT SEQ_NO (#PCDATA)> 
<!ELEMENT ENG_NAME_1 (#PCDATA)> 
<!ELEMENT ENG_NAME_2 (#PCDATA)> 
<!ELEMENT ENG_NAME_3 (#PCDATA)> 
<!ELEMENT CHIN_NAME (#PCDATA)> 
<!ELEMENT PRN (#PCDATA)> 
<!ELEMENT PASSPORT_NO (#PCDATA)> 
<!ELEMENT BRN (#PCDATA)> 
<!ELEMENT OTHER_COMPANY_NO (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_1 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_2 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_3 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_4 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_5 (#PCDATA)> 
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5.4 UNLISTED SHARE TRANSFER (SALE AND PURCHASE) 

<!ELEMENT TRANSACTIONS (TRANSACTION*)> 
<!ATTLIST TRANSACTIONS version CDATA '1.0'> 

 
<!-- Field Definitions for TRANSACTIONS Element --> 
<!ELEMENT TRANSACTION (TRANSACTION_NUM, TRANSACTION_NATURE, 
SHARES_NATURE, DOC_IT, DOC_BNOTE, DOC_SNOTE, EXECUTION_DATE, 
EXECUTION_PLACE, NUM_SHARES, CONSIDERATION, AGREEMENT_EXECUTED, 
COMPANY_BR_NO, OTHER_BUSINESS_NO, COMPANY_CHIN_NAME, 
COMPANY_ENG_NAME_L1, COMPANY_ENG_NAME_L2,    COMPANY_ENG_NAME_L3,    
COMPANY_COMMENCE_BUSINESS, COMPANY_OWN_PROPERTY,     
COMPANY_OWN_SUBSIDIARY, VALUE_REFERENCE_ACCOUNTS, PRICE_PER_SHARE, 
ACCOUNT_DATE, OTHER_ASSET, TOTAL_LIABILITIES, ISSUED_SHARE, TRANSFER_PARTY+)> 

 
 

<!-- Field Definitions for TRANSACTION Element --> 
<!ELEMENT TRANSACTION_NUM (#PCDATA)> 
<!ELEMENT TRANSACTION_NATURE (#PCDATA)> 
<!ELEMENT SHARES_NATURE (#PCDATA)> 
<!ELEMENT DOC_IT (#PCDATA)> 
<!ELEMENT DOC_BNOTE (#PCDATA)> 
<!ELEMENT DOC_SNOTE (#PCDATA)> 
<!ELEMENT EXECUTION_DATE (#PCDATA)> 
<!ELEMENT EXECUTION_PLACE (#PCDATA)> 
<!ELEMENT NUM_SHARES (#PCDATA)> 
<!ELEMENT CONSIDERATION (#PCDATA)> 
<!ELEMENT AGREEMENT_EXECUTED (#PCDATA)> 
<!ELEMENT COMPANY_BR_NO (#PCDATA)> 
<!ELEMENT OTHER_BUSINESS_NO (#PCDATA)> 
<!ELEMENT COMPANY_CHIN_NAME (#PCDATA)> 
<!ELEMENT COMPANY_ENG_NAME_L1 (#PCDATA)> 
<!ELEMENT COMPANY_ENG_NAME_L2 (#PCDATA)> 
<!ELEMENT COMPANY_ENG_NAME_L3 (#PCDATA)> 
<!ELEMENT COMPANY_COMMENCE_BUSINESS (#PCDATA)> 
<!ELEMENT COMPANY_OWN_PROPERTY (#PCDATA)> 
<!ELEMENT COMPANY_OWN_SUBSIDIARY (#PCDATA)> 
<!ELEMENT VALUE_REFERENCE_ACCOUNTS (#PCDATA)> 
<!ELEMENT PRICE_PER_SHARE (#PCDATA)> 
<!ELEMENT ACCOUNT_DATE (#PCDATA)> 
<!ELEMENT OTHER_ASSET (#PCDATA)> 
<!ELEMENT TOTAL_LIABILITIES (#PCDATA)> 
<!ELEMENT ISSUED_SHARE (#PCDATA)> 

 
<!ELEMENT TRANSFER_PARTY (PARTY_TYPE, SEQ_NO, ENG_NAME_1, ENG_NAME_2, 
ENG_NAME_3, CHIN_NAME, PRN, PASSPORT_NO, BRN, OTHER_COMPANY_NO, 
ENG_CORR_ADDR_1, ENG_CORR_ADDR_2, ENG_CORR_ADDR_3, ENG_CORR_ADDR_4, 
ENG_CORR_ADDR_5 )> 

 
<!ELEMENT PARTY_TYPE (#PCDATA)> 
<!ELEMENT SEQ_NO (#PCDATA)> 
<!ELEMENT ENG_NAME_1 (#PCDATA)> 
<!ELEMENT ENG_NAME_2 (#PCDATA)> 
<!ELEMENT ENG_NAME_3 (#PCDATA)> 
<!ELEMENT CHIN_NAME (#PCDATA)> 
<!ELEMENT PRN (#PCDATA)> 
<!ELEMENT PASSPORT_NO (#PCDATA)> 
<!ELEMENT BRN (#PCDATA)> 
<!ELEMENT OTHER_COMPANY_NO (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_1 (#PCDATA)> 
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<!ELEMENT ENG_CORR_ADDR_2 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_3 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_4 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_5 (#PCDATA)> 
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5.5 UNLISTED SHARE TRANSFER (OTHER THAN SALE AND 
PURCHASE) 

<!ELEMENT TRANSACTIONS (TRANSACTION*)> 
<!ATTLIST TRANSACTIONS version CDATA '1.0'> 

 
<!-- Field Definitions for TRANSACTIONS Element --> 
<!ELEMENT TRANSACTION (TRANSACTION_NUM, TRANSACTION_NATURE, 
SHARES_NATURE, DOC_IT, EXECUTION_DATE, EXECUTION_PLACE, NUM_SHARES, 
COMPANY_BR_NO, OTHER_BUSINESS_NO, COMPANY_CHIN_NAME, 
COMPANY_ENG_NAME_L1, COMPANY_ENG_NAME_L2,    COMPANY_ENG_NAME_L3,    
COMPANY_COMMENCE_BUSINESS, COMPANY_OWN_PROPERTY,     
COMPANY_OWN_SUBSIDIARY, VALUE_REFERENCE_ACCOUNTS, PRICE_PER_SHARE, 
ACCOUNT_DATE, OTHER_ASSET, TOTAL_LIABILITIES, ISSUED_SHARE, 
TRANSFER_PARTY+)> 

 
 

<!-- Field Definitions for TRANSACTION Element --> 
<!ELEMENT TRANSACTION_NUM (#PCDATA)> 
<!ELEMENT TRANSACTION_NATURE (#PCDATA)> 
<!ELEMENT SHARES_NATURE (#PCDATA)> 
<!ELEMENT DOC_IT (#PCDATA)> 
<!ELEMENT EXECUTION_DATE (#PCDATA)> 
<!ELEMENT EXECUTION_PLACE (#PCDATA)> 
<!ELEMENT NUM_SHARES (#PCDATA)> 
<!ELEMENT COMPANY_BR_NO (#PCDATA)> 
<!ELEMENT OTHER_BUSINESS_NO (#PCDATA)> 
<!ELEMENT COMPANY_CHIN_NAME (#PCDATA)> 
<!ELEMENT COMPANY_ENG_NAME_L1 (#PCDATA)> 
<!ELEMENT COMPANY_ENG_NAME_L2 (#PCDATA)> 
<!ELEMENT COMPANY_ENG_NAME_L3 (#PCDATA)> 
<!ELEMENT COMPANY_COMMENCE_BUSINESS (#PCDATA)> 
<!ELEMENT COMPANY_OWN_PROPERTY (#PCDATA)> 
<!ELEMENT COMPANY_OWN_SUBSIDIARY (#PCDATA)> 
<!ELEMENT VALUE_REFERENCE_ACCOUNTS (#PCDATA)> 
<!ELEMENT PRICE_PER_SHARE (#PCDATA)> 
<!ELEMENT ACCOUNT_DATE (#PCDATA)> 
<!ELEMENT OTHER_ASSET (#PCDATA)> 
<!ELEMENT TOTAL_LIABILITIES (#PCDATA)> 
<!ELEMENT ISSUED_SHARE (#PCDATA)> 

 
<!ELEMENT TRANSFER_PARTY (PARTY_TYPE, SEQ_NO, ENG_NAME_1, ENG_NAME_2, 
ENG_NAME_3, CHIN_NAME, PRN, PASSPORT_NO, BRN, OTHER_COMPANY_NO, 
ENG_CORR_ADDR_1, ENG_CORR_ADDR_2, ENG_CORR_ADDR_3, ENG_CORR_ADDR_4, 
ENG_CORR_ADDR_5 )> 

 
<!ELEMENT PARTY_TYPE (#PCDATA)> 
<!ELEMENT SEQ_NO (#PCDATA)> 
<!ELEMENT ENG_NAME_1 (#PCDATA)> 
<!ELEMENT ENG_NAME_2 (#PCDATA)> 
<!ELEMENT ENG_NAME_3 (#PCDATA)> 
<!ELEMENT CHIN_NAME (#PCDATA)> 
<!ELEMENT PRN (#PCDATA)> 
<!ELEMENT PASSPORT_NO (#PCDATA)> 
<!ELEMENT BRN (#PCDATA)> 
<!ELEMENT OTHER_COMPANY_NO (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_1 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_2 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_3 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_4 (#PCDATA)> 
<!ELEMENT ENG_CORR_ADDR_5 (#PCDATA)> 
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APPENDIX A DATA SPECIFICATION 

This section describes the format of the XML file for upload of stamping requests to the e-Stamping service. 

Conventions used in the interface data definition are as follows: 
1. The XML file should be encoded and saved in UTF-8 format. 
2. All text fields are English fields unless otherwise stated. 
3. All bilingual fields are handled as Chinese content if there is at least one Chinese character in the field. 
4. Date formats 

- Format Date denotes YYYYMMDD. 
- Format X(n) denotes character string data with maximum n character(s) 
- Format 9(n,m) denotes number with maximum p digits (precision) and maximum m digits to the right of the decimal point (scale) 

5. Values under the Repeat Group column represent the identifier for the group of data items that may be repeated. 
6. An element’s value is considered optional for the data upload unless ‘Mandatory’ is specified in the data rule. 
7. <!DOCTYPE html definition is not allowed. 
8. <!--comment disallowed. 
9. Elements must be in the same order as specified in Section 5. 
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A.1 LISTED SHARE TRANSFER (SALE AND PURCHASE) 
 

Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

All upload records should be included in block TRANSACTIONS. For each record, the content should be included in block TRANSACTION. 
 

The maximum number of the repeating group TRANSFER_PARTY in each TRANSACTION is eight (four transferors and four transferees). 
Must enter at least one Transferor and one Transferee. 
TRANSACTION       

 Transaction 
Number 

TRANSACTION_ 
NUM 

Transaction number indicating the record count. 
Content value should be from 1 to 5000. 

Mandatory  9(4) 

 Nature of 
Transaction 

TRANSACTION_ 
NATURE 

Type of transaction, content should be filled 
with 1-character short code only, must be “1”: 

 
Short Code – description 
------------------------------- 
“1” – Sale and purchase 
“2” – Other than sale and purchase 

Mandatory  X(1) 

 Nature of 
Shares 

SHARES_NATURE Nature of share, content should be filled with 1- 
character short code only, must be “1”: 

 
Short Code – description 
------------------------------- 
“1” – Listed Share 
“2” – Unlisted Share 

Mandatory  X(1) 

 Instrument of 
Transfer 

DOC_IT Indicator of whether to stamp instrument of 
transfer. Content should be filled with 1- 
character short code only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

 
If “Y”, DOC_BNOTE and DOC_SNOTE must 
be “Y” too. 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

 Bought Note DOC_BNOTE Indicator of whether to stamp bought note. 
Content should be filled with 1-character short 
code only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Sold Note DOC_SNOTE Indicator of whether to stamp sold note. Content 
should be filled with 1-character short code 
only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Date of 
Execution 

EXECUTION_DATE Date of execution 
 

All transactions should bear the same execution 
date. 

 
Format should be YYYYMMDD. 

Mandatory  9(8) 

 Place of 
Execution 

EXECUTION_PLACE Place of execution, content should be filled with 
1-character short code only: 

 
Short Code – description 
------------------------------ 
“H” – Hong Kong 
“O” – Outside Hong Kong 

 
All transactions shall be executed either in Hong 
Kong, or outside Hong Kong. 

Mandatory  X(1) 

 Number of 
Shares 

NUM_SHARES Number of shares under transfer 
 

The input should be greater than 0 and up to 
999999999999.9 and may have 1 decimal place. 

Mandatory  9(13,1) 
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 Total 

Consideration 
CONSIDERATION Total consideration in Hong Kong dollar 

 
The input should be greater than 0 and up to 
999999999999.99 and may have 2 decimal 
places. 

Mandatory  9(14,2) 

 Agreement for 
Sale and 
Purchase 
Executed 

AGREEMENT_ 
EXECUTED 

Indicator of whether an agreement for sale and 
purchase was executed for the transfer. Content 
should be filled with 1-character short code 
only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Stock Code STOCK_CODE Stock code 
 

Must be numeric and valid Stock Code. 

The input should be from 0 to 99999. 

The stock must not be denominated in currency 
other than HKD, RMB or USD. 

Mandatory  9(5) 

 Stock Chinese 
Name 

STOCK_CHIN_NAME Subject share Chinese name 
 

Input Chinese characters, maximum 60 
characters allowed. 

Mandatory to 
input either 
ENG/CHI or 
both 

 X(60) 

 Stock English 
Name 

STOCK_ENG_NAME Subject share English name 
 

Input English characters, maximum 150 
characters allowed. 

  X(150) 

 Party Type PARTY_TYPE Type of party 
Content should be filled with 1-character short 
code only: 

 
Short Code – description 
------------------------------- 
“S” – Transferor 
“B” – Transferee 

Mandatory TRANSFER_PARTY X(1) 
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 Sequence 

Number 
SEQ_NO Sequence number indicating the party number. 

Content value should be from 1 to 4. 
 

Same number indicated in PARTY_TYPE. 

Mandatory TRANSFER_PARTY 9(1) 

 Party English 
Name 

ENG_NAME_1 Line1, Line2, Line3 of the party English name 
 

Input English characters, maximum 50 
characters allowed every line. 

Mandatory to 
input either 
ENG/CHI or 
both 

TRANSFER_PARTY X(50) 
ENG_NAME_2 TRANSFER_PARTY X(50) 
ENG_NAME_3 TRANSFER_PARTY X(50) 

 Party Chinese 
Name 

CHIN_NAME Party Chinese name 

Input Chinese characters. 

For an individual, maximum 6 characters 
allowed. 

 
For an organization, maximum 50 characters 
allowed. 

TRANSFER_PARTY X(50) 

 HK Identity 
Card Number 

PRN HKIC Number - for individual with Hong Kong 
identity card 

 
For A123456(7), input as A1234567. 

Mandatory to 
input either 
PRN, 
PASSPORT_ 
NO, BRN or 
OTHER_ 
COMPANY_ 
NO 

TRANSFER_PARTY X(9) 

 Passport 
Number 

PASSPORT_NO Passport Number - for individual without Hong 
Kong identity card 

 
Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Business 
Registration 
Number 

BRN Business registration number 
 

Input numbers. 

TRANSFER_PARTY 9(8) 

 Other Company 
Number 

OTHER_COMPANY_ 
NO 

Other company number 
 

Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Correspondence 
Address 

ENG_CORR_ADDR_1 For English correspondence address, maximum 
30 characters allowed every line. 

 
For Chinese correspondence address, maximum 
20 Chinese characters allowed every line. (Only 
line 1 to 3 is allowed.) 

Mandatory TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_2  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_3  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_4  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_5  TRANSFER_PARTY X(30) 
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A.2 LISTED SHARE TRANSFER (OTHER THAN SALE AND PURCHASE) 
 

Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

All upload records should be included in block TRANSACTIONS. For each record, the content should be included in block TRANSACTION. 
 

The maximum number of the repeating group TRANSFER_PARTY in each TRANSACTION is eight (four transferors and four transferees). 
Must enter at least one Transferor and one Transferee. 
TRANSACTION       

 Transaction 
Number 

TRANSACTION_ 
NUM 

Transaction number indicating the record count. 
Content value should be from 1 to 5000. 

Mandatory  9(4) 

 Nature of 
Transaction 

TRANSACTION_ 
NATURE 

Type of transaction, content should be filled 
with 1-character short code only, must be “2”: 

 
Short Code – description 
------------------------------- 
“1” – Sale and purchase 
“2” – Other than sale and purchase 

Mandatory  X(1) 

 Nature of 
Shares 

SHARES_NATURE Nature of share, content should be filled with 1- 
character short code only, must be “1”: 

 
Short Code – description 
------------------------------- 
“1” – Listed Share 
“2” – Unlisted Share 

Mandatory  X(1) 

 Instrument of 
Transfer 

DOC_IT Indicator of whether to stamp instrument of 
transfer. Content should be filled with 1- 
character short code only, must be “Y”: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

 Date of 
Execution 

EXECUTION_DATE Date of execution 
 
All transactions should bear the same execution 
date. 

 
Format should be YYYYMMDD. 

Mandatory  9(8) 

 Place of 
Execution 

EXECUTION_PLACE Place of execution, content should be filled with 
1-character short code only: 

 
Short Code – description 
------------------------------ 
“H”– Hong Kong 
“O” – Outside Hong Kong 

 
All transactions shall be executed either in Hong 
Kong, or outside Hong Kong. 

Mandatory  X(1) 

 Number of 
Shares 

NUM_SHARES Number of shares under transfer 
 
The input should be greater than 0 and up to 
999999999999.9 and may have 1 decimal place. 

Mandatory  9(13,1) 

 Stock Code STOCK_CODE Stock code 
 
Must be numeric and valid Stock Code. 

The input should be from 0 to 99999. 

The stock must not be denominated in currency 
other than HKD, RMB or USD. 

Mandatory  9(5) 

 Stock Chinese 
Name 

STOCK_CHIN_NAME Subject share Chinese name 
 
Input Chinese characters, maximum 60 
characters allowed. 

Mandatory to 
input either 
ENG/CHI or 
both 

 X(60) 

 Stock English 
Name 

STOCK_ENG_NAME Subject share English name 
 
Input English characters, maximum 150 
characters allowed. 

  X(150) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Nominee 
Indicator 

NOMINEE_IND Indicator of whether the transfer is for 
appointment of nominee or change of nominee 
which does not involve a change in beneficial 
ownership. Content should be filled with 1- 
character short code only, must be “N”: 

 
Short Code – description 
------------------------------- 
“Y”– Yes 
“N”– No 

Mandatory  X(1) 

 Party Type PARTY_TYPE Type of party 
Content should be filled with 1-character short 
code only: 

 
Short Code – description 
------------------------------- 
“S” – Transferor 
“B” - Transferee 

Mandatory TRANSFER_PARTY X(1) 

 Sequence 
Number 

SEQ_NO Sequence number indicating the party number. 
Content value should be from 1 to 4. 

 
Same number indicated in PARTY_TYPE. 

Mandatory TRANSFER_PARTY 9(1) 

 Party English 
Name 

ENG_NAME_1 Line1, Line2, Line3 of the party English name 
 
Input English characters, maximum 50 
characters allowed every line. 

Mandatory to 
input either 
ENG/CHI or 
both 

TRANSFER_PARTY X(50) 
ENG_NAME_2 TRANSFER_PARTY X(50) 
ENG_NAME_3 TRANSFER_PARTY X(50) 

 Party Chinese 
Name 

CHIN_NAME Party Chinese name 

Input Chinese characters. 

For an individual, maximum 6 characters 
allowed. 

 
For an organization, maximum 50 characters 
allowed. 

TRANSFER_PARTY X(50) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 HK Identity 
Card Number 

PRN HKIC Number - for individual with Hong Kong 
identity card 

 
For A123456(7), input as A1234567. 

Mandatory to 
input either 
PRN, 
PASSPORT_ 
NO, BRN or 
OTHER_ 
COMPANY_ 
NO 

TRANSFER_PARTY X(9) 

 Passport 
Number 

PASSPORT_NO Passport Number - for individual without Hong 
Kong identity card 

 
Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Business 
Registration 
Number 

BRN Business registration number 
 
Input numbers. 

TRANSFER_PARTY 9(8) 

 Other Company 
Number 

OTHER_COMPANY_ 
NO 

Other company number 
 
Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Correspondence 
Address 

ENG_CORR_ADDR_1 For English correspondence address, maximum 
30 characters allowed every line. 

 
 
For Chinese correspondence address, maximum 
20 Chinese characters allowed every line. (Only 
line 1 to 3 is allowed.) 

Mandatory TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_2  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_3  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_4  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_5  TRANSFER_PARTY X(30) 
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A.3 LISTED SHARE TRANSFER (CHANGE OF NOMINEE) 
 

Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

All upload records should be included in block TRANSACTIONS. For each record, the content should be included in block TRANSACTION. 
 

The maximum number of the repeating group TRANSFER_PARTY in each TRANSACTION is eight (four transferors and four transferees). 
Must enter at least one Transferor and one Transferee. 
TRANSACTION       

 Transaction 
Number 

TRANSACTION_ 
NUM 

Transaction number indicating the record count. 
Content value should be from 1 to 5000. 

Mandatory  9(4) 

 Nature of 
Transaction 

TRANSACTION_ 
NATURE 

Type of transaction, content should be filled 
with 1-character short code only, must be “2”: 

 
Short Code – description 
------------------------------- 
“1” – Sale and purchase 
“2” – Other than sale and purchase 

Mandatory  X(1) 

 Nature of 
Shares 

SHARES_NATURE Nature of share, content should be filled with 1- 
character short code only, must be “1”: 

 
Short Code – description 
------------------------------- 
“1” – Listed Share 
“2” – Unlisted Share 

Mandatory  X(1) 

 Instrument of 
Transfer 

DOC_IT Indicator of whether to stamp instrument of 
transfer. Content should be filled with 1- 
character short code only, must be ‘Y’: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

 Date of 
Execution 

EXECUTION_DATE Date of execution 
 

All transactions should bear the same execution 
date. 

 
Format should be YYYYMMDD. 

Mandatory  9(8) 

 Place of 
Execution 

EXECUTION_PLACE Place of execution, content should be filled with 
1-character short code only: 

 
Short Code – description 
------------------------------ 
“H” – Hong Kong 
“O” – Outside Hong Kong 

 
All transactions shall be executed either in 
Hong Kong, or outside Hong Kong. 

Mandatory  X(1) 

 Number of 
shares 

NUM_SHARES Number of shares under transfer 
 

The input should be greater than 0 and up to 
999999999999.9 and may have 1 decimal place. 

Mandatory  9(13,1) 

 Stock Code STOCK_CODE Stock code 
 

Must be numeric and valid Stock Code. 

The input should be from 0 to 99999. 

The stock must not be denominated in currency 
other than HKD, RMB or USD. 

Mandatory  9(5) 

 Stock Chinese 
Name 

STOCK_CHIN_NAME Subject share Chinese name 
 

Input Chinese characters, maximum 60 
characters allowed. 

Mandatory to 
input either 
ENG/CHI or 
both 

 X(60) 

 Stock English 
Name 

STOCK_ENG_NAME Subject share English name 
 

Input English characters, maximum 150 
characters allowed. 

  X(150) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Nominee 
Indicator 

NOMINEE_IND Indicator of whether the transfer is for 
appointment of nominee or change of nominee 
which does not involve a change in beneficial 
ownership. Content should be filled with 1- 
character short code only, must be “Y”: 

 
Short code – description 
------------------------------ 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Party Type PARTY_TYPE Type of party 
Content should be filled with 1-character short 
code only: 

 
Short Code – description 
------------------------------- 
“S” – Transferor 
“B” - Transferee 

Mandatory TRANSFER_PARTY X(1) 

 Sequence 
Number 

SEQ_NO Sequence number indicating the party number. 
Content value should be from 1 to 4. 

 
Same number indicated in PARTY_TYPE. 

Mandatory TRANSFER_PARTY 9(1) 

 Party English 
Name 

ENG_NAME_1 Line1, Line2, Line3 of the party English name 
 

Input English characters, maximum 50 
characters allowed every line. 

Mandatory to 
input either 
ENG/CHI or 
both 

TRANSFER_PARTY X(50) 
ENG_NAME_2 TRANSFER_PARTY X(50) 
ENG_NAME_3 TRANSFER_PARTY X(50) 

 Party Chinese 
Name 

CHIN_NAME Party Chinese name 

Input Chinese characters. 

For an individual, maximum 6 characters 
allowed. 

 
For an organization, maximum 50 characters 
allowed. 

TRANSFER_PARTY X(50) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 HK Identity 
Card Number 

PRN HKIC Number - for individual with Hong Kong 
identity card 

 
For A123456(7), input as A1234567. 

Mandatory to 
input either 
PRN, 
PASSPORT_ 
NO, BRN or 
OTHER_ 
COMPANY_ 
NO 

TRANSFER_PARTY X(9) 

 Passport 
Number 

PASSPORT_NO Passport Number - for individual without Hong 
Kong identity card 

 
Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Business 
Registration 
Number 

BRN Business registration number 
 

Input numbers. 

TRANSFER_PARTY 9(8) 

 Other Company 
Number 

OTHER_COMPANY_ 
NO 

Other company number 
 

Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Correspondence 
Address 

ENG_CORR_ADDR_1 For English correspondence address, maximum 
30 characters allowed every line 

 
For Chinese correspondence address, maximum 
20 Chinese characters allowed every line. (Only 
line 1 to 3 is allowed.) 

Mandatory TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_2  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_3  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_4  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_5  TRANSFER_PARTY X(30) 
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A.4 UNLISTED SHARE TRANSFER (SALE AND PURCHASE) 
 

Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

All upload records should be included in block TRANSACTIONS. For each record, the content should be included in block TRANSACTION. 
 

The maximum number of the repeating group TRANSFER_PARTY in each TRANSACTION is eight (four transferors and four transferees). 
Must enter at least one Transferor and one Transferee. 
TRANSACTION       

 Transaction 
Number 

TRANSACTION_NUM Transaction number indicating the record count. 
 

Content value should be from 1 to 1666 (= max 
4998 instruments) 

Mandatory  9(4) 

 Nature of 
Transaction 

TRANSACTION_ 
NATURE 

Type of transaction, content should be filled 
with 1-character short code only, must be “1”: 

 
Short Code – description 
------------------------------- 
“1” – Sale and purchase 
“2” – Other than sale and purchase 

Mandatory  X(1) 

 Nature of 
Shares 

SHARES_NATURE Nature of share, content should be filled with 1- 
character short code only, must be “2”: 

 
Short Code – description 
------------------------------- 
“1” – Listed Share 
“2” – Unlisted Share 

Mandatory  X(1) 

 Instrument of 
Transfer 

DOC_IT Indicator of whether to stamp instrument of 
transfer. Content should be filled with 1- 
character short code only, must be “Y”: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

 Bought Note DOC_BNOTE Indicator of whether to stamp bought note. 
Content should be filled with 1-character short 
code only, must be “Y”: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Sold Note DOC_SNOTE Indicator of whether to stamp sold note. 
Content should be filled with 1-character short 
code only, must be “Y”: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Date of 
Execution 

EXECUTION_DATE Date of execution 
 

All transactions should bear the same execution 
date. 

 
Format should be YYYYMMDD. 

Mandatory  9(8) 

 Place of 
Execution 

EXECUTION_PLACE Place of execution, content should be filled with 
1-character short code only: 

 
Short Code – description 
------------------------------ 
“H” – Hong Kong 
“O” – Outside Hong Kong 

 
All transactions shall be executed either in 
Hong Kong or outside Hong Kong. 

Mandatory  X(1) 

 Number of 
Shares 

NUM_SHARES Number of shares under transfer 
 

The input should be greater than 0 and up to 
999999999999.9 and may have 1 decimal place. 

Mandatory  9(13,1) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Total 
Consideration 

CONSIDERATION Total consideration in Hong Kong dollar 
 

The input should be greater than 0 and up to 
999999999999.99 and may have 2 decimal 
places. 

Mandatory  9(14,2) 

 Agreement for 
Sale and 
Purchase 
Executed 

AGREEMENT_ 
EXECUTED 

Indicator of whether an agreement for sale and 
purchase was executed for the transfer. Content 
should be filled with 1-character short code 
only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Business COMPANY_BR_NO Business registration number of the subject Mandatory to  9(8) 
Registration company input either 
Number  BR/Other  

Input numbers. Business Number 
but not both  Other 

Business 
Number 

OTHER_BUSINESS_N
O 

Other business number of the subject 
company 

 
Input alphanumeric characters. 

 X(10) 

 Company 
Chinese Name 

COMPANY_CHIN_NA 
ME 

Subject company Chinese name 
 

Input Chinese characters, maximum 50 
characters allowed. 

Mandatory to 
input either 
ENG/CHI or 
both 

 X(50) 

 Company 
English Name 

COMPANY_ENG_ 
NAME_L1 

Line1, Line2, Line3 Subject company English 
Name 

 
Input English characters, maximum 50 
characters allowed every line. 

 X(50) 

COMPANY_ENG_ 
NAME_L2 

 X(50) 

COMPANY_ENG_ 
NAME_L3 

 X(50) 
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Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

 Company 
Commenced 
Business 

COMPANY_ 
COMMENCE_ 
BUSINESS 

Indicator of whether the subject company has 
commenced business, content should be filled 
with 1-character short code only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Company Own 
Property 

COMPANY_OWN_ 
PROPERTY 

Indicator of whether the subject company owns 
landed property, or right to acquire landed 
property (include land lots). Content should be 
filled with 1-character short code only, must be 
‘N’: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Company Own 
Subsidiary 

COMPANY_OWN_ 
SUBSIDIARY 

Indicator of whether the subject company owns 
subsidiary, content should be filled with 1- 
character short code only, must be ‘N’: 

 
Short code – description 
------------------------------ 
“Y” – Yes 
“N”– No 

Mandatory  X(1) 

 Consolidated 
Accounts 

VALUE_REFERENCE 
_ACCOUNTS 

Whether value of share is calculated with 
reference to consolidated accounts, content 
should be filled with 1-character short code 
only, must be “N”: 

 
Short code – description 
------------------------------ 
“Y”– Yes 
“N”– No 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

 Subscription 
Price (per 
Share) 

PRICE_PER_SHARE Subscription price (per share) 
 

Input should be greater than 0 and up to 
99999999999999.999 and may have 2 decimal 
places. 

 
PRICE_PER_SHARE X NUM_SHARE should 
be less than 999999999999.99 

Mandatory if 
COMPANY_ 
COMMENCE_ 
BUSINESS = 
“N” 

 
Must be blank if 
COMPANY_ 
COMMENCE_ 
BUSINESS = 
“Y” 

  
9(16,2) 

 Date of Latest 
Audited/ 
Management 
Accounts 

ACCOUNT_DATE Date of the latest audited / management 
accounts 

 
The audited/management accounts must be 
made up to a date within 6 months prior to the 
date of share transfer. 

 
Format should be YYYYMMDD. 

4 elements 
mandatory if 
COMPANY_ 
COMMENCE_ 
BUSINESS = 
“Y” 

 
All 4 elements 
must be blank if 
COMPANY_ 
COMMENCE_ 
BUSINESS is 
“N” 

 9(8) 

 Total Assets OTHER_ASSET Total assets 
 

Input should be greater than 0 and up to 
99999999999999.99 and may have 2 decimal 
places. 

  9(16,2) 

 Total Liabilities TOTAL_LIABILITIES Total liabilities 
 

Input should be greater than 0 and up to 
99999999999999.99 and may have 2 decimal 
places. 

  9(16,2) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Number of 
Issued Shares 

ISSUED_SHARE Number of issued shares 
 

The input should be greater than 0 and up to 
999999999999. 

  9(12) 

 Party Type PARTY_TYPE Type of party 
Content should be filled with 1-character short 
code only: 

 
Short Code – description 
------------------------------- 
“S” – Transferor 
“B” – Transferee 

Mandatory TRANSFER_PARTY X(1) 

 Sequence 
Number 

SEQ_NO Sequence Number indicating the party number. 
Content value should be from 1 to 4. 

 
Same number indicated in PARTY_TYPE. 

Mandatory TRANSFER_PARTY 9(1) 

 Party English 
Name 

ENG_NAME_1 Line1, Line2, Line3 of the party English name 
 

Input English characters, maximum 50 
characters allowed every line. 

Mandatory to 
input either 
ENG/CHI or 
both 

TRANSFER_PARTY X(50) 
ENG_NAME_2 TRANSFER_PARTY X(50) 
ENG_NAME_3 TRANSFER_PARTY X(50) 

 Party Chinese 
Name 

CHIN_NAME Party Chinese name 

Input Chinese characters. 

For an individual, maximum 6 characters 
allowed. 

 
For an organization, maximum 50 characters 
allowed. 

TRANSFER_PARTY X(50) 

 HK Identity 
Card Number 

PRN HKIC Number - for individual with Hong Kong 
identity card 

 
For A123456(7), input as A1234567. 

Mandatory to 
input either 
PRN, 
PASSPORT_ 
NO, BRN or 
OTHER_ 
COMPANY_ 
NO 

TRANSFER_PARTY X(9) 

 Passport 
Number 

PASSPORT_NO Passport Number - for individual without Hong 
Kong identity card 

 
Input alphanumeric characters. 

TRANSFER_PARTY X(30) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Business 
Registration 
Number 

BRN Business registration number 
 

Input numbers. 

 TRANSFER_PARTY 9(8) 

 Other Company 
Number 

OTHER_COMPANY_ 
NO 

Other company number 
 

Input alphanumeric characters. 

TRANSFER_PARTY X(30) 

 Correspondence 
Address 

ENG_CORR_ADDR_1 For English correspondence address, maximum 
30 characters allowed every line. 

 
For Chinese correspondence address, maximum 
20 Chinese characters every line. 
(Only line 1 to 3 is allowed.) 

Mandatory TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_2  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_3  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_4  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_5  TRANSFER_PARTY X(30) 
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A.5 UNLISTED SHARE TRANSFER (OTHER THAN SALE AND PURCHASE) 
 

Group Name Element Name Description Data Rules for 
upload 

Repeat Group Format 

All upload records should be included in block TRANSACTIONS. For each record, the content should be included in block TRANSACTION. 
 

The maximum number of the repeating group TRANSFER_PARTY in each TRANSACTION is eight (four transferors and four transferees). 
Must enter at least one Transferor and one Transferee. 
TRANSACTION       

 Transaction 
Number 

TRANSACTION_NUM Transaction number indicating the record count. 
Content value should be from 1 to 5000. 

Mandatory  9(4) 

 Nature of 
Transaction 

TRANSACTION_ 
NATURE 

Type of transaction, content should be filled 
with 1-character short code only, must be “2”: 

 
Short Code – description 
------------------------------- 
“1” – Sale and purchase 
“2” – Other than sale and purchase 

Mandatory  X(1) 

 Nature of 
Shares 

SHARES_NATURE Nature of share, content should be filled with 1- 
character short code only, must be “2”: 

 
Short Code – description 
------------------------------- 
“1” – Listed Share 
“2” – Unlisted Share 

Mandatory  X(1) 

 Instrument of 
Transfer 

DOC_IT Indicator of whether to stamp instrument of 
transfer. Content should be filled with 1- 
character short code only, must be “Y”: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Date of 
Execution 

EXECUTION_DATE Date of execution 
 

All transactions should bear the same execution 
date. 

 
Format should be YYYYMMDD. 

Mandatory  9(8) 

 Place of 
Execution 

EXECUTION_PLACE Place of execution, content should be filled with 
1-character short code only: 

 
Short Code – description 
------------------------------ 
“H” – Hong Kong 
“O” – Outside Hong Kong 

 
All transactions shall be executed in Hong 
Kong, or outside Hong Kong. 

Mandatory  X(1) 

 Number of 
Shares 

NUM_SHARES Number of shares under transfer 
 

The input should be greater than 0 and up to 
999999999999.9 and may have 1 decimal place. 

Mandatory  9(13,1) 

 Business COMPANY_BR_NO Business registration number of the subject Mandatory to  9(8) 
Registration company input either 
Number  BR/Other  

Input numbers. Business Number 
but not both  Other 

Business 
Number 

OTHER_BUSINESS_NO Other business number of the subject 
company 

 
Input alphanumeric characters. 

 X(10) 

 Company 
Chinese Name 

COMPANY_CHIN_ 
NAME 

Subject company Chinese name 
 

Input Chinese characters, maximum 50 
characters allowed. 

Mandatory to 
input either 
ENG/CHI or 
both 

 X(50) 

 Company 
English Name 

COMPANY_ENG_ 
NAME_L1 

Line1, Line2, Line3 subject company English 
Name 

 
Input English characters, maximum 50 

 X(50) 

COMPANY_ENG_ 
NAME_L2 

 X(50) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

  COMPANY_ENG_ 
NAME_L3 

characters allowed every line.   X(50) 

 Company 
Commenced 
Business 

COMPANY_ 
COMMENCE_ 
BUSINESS 

Indicator of whether the subject company has 
commenced business, content should be filled 
with 1-character short code only: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Company Own 
Property 

COMPANY_OWN_ 
PROPERTY 

Indicator of whether the subject company owns 
landed property, or right to acquire landed 
property (include land lots). Content should be 
filled 1-character with short code only, must be 
‘N’: 

 
Short Code – description 
------------------------------- 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Company Own 
Subsidiary 

COMPANY_OWN_ 
SUBSIDIARY 

Indicator of whether the subject company owns 
subsidiary, content should be filled with 1- 
character short code only, must be ‘N’: 

 
Short code – description 
------------------------------ 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 

 Consolidated 
accounts 

VALUE_REFERENCE 
_ACCOUNTS 

Indicator of whether value of share is calculated 
with reference to consolidated accounts, content 
should be filled with 1-character short code 
only, must be “N”: 

 
Short code – description 
------------------------------ 
“Y” – Yes 
“N” – No 

Mandatory  X(1) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Subscription 
Price (per 
Share) 

PRICE_PER_SHARE Subscription price (per share) 
 

Input should be greater than 0 and up to 
99999999999999.99 and may have 2 decimal 
places. 

Mandatory if 
COMPANY_ 
COMMENCE_ 
BUSINESS is 
“N” 

 
Must be blank if 
COMPANY_ 
COMMENCE_ 
BUSINESS = 
“Y” 

  
9(16,2) 

 Date of Latest 
Audited/ 
Management 
Account 

ACCOUNT_DATE Date of the Latest Audited / Management 
Accounts 

 
The audited/management accounts must be 
made up to a date within 6 months prior to the 
date of share transfer. 

 
Format should be YYYYMMDD. 

Mandatory to 
input all 4 
elements if 
COMPANY_ 
COMMENCE_ 
BUSINESS is 
“Y” 

 
All 4 elements 
must be blank if 
COMPANY_ 
COMMENCE_ 
BUSINESS is 
“N” 

 9(8) 

 Total Assets OTHER_ASSET Total Assets 
 

Input should be greater than 0 and up to 
99999999999999.99 and may have 2 decimal 
places. 

 9(16,2) 

 Total Liabilities TOTAL_LIABILITIES Total Liabilities 
 

Input should be greater than 0 and up to 
99999999999999.99 and may have 2 decimal 
places. 

 9(16,2) 

 Number of 
Issued Shares 

ISSUED_SHARE Number of issued shares 
 

The input should be greater than 0 and up to 
999999999999. 

 9(12) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Party Type PARTY_TYPE Type of party 
Content should be filled with 1-character short 
code only: 

 
Short Code – description 
------------------------------- 
“S”- Transferor 
“B”- Transferee 

Mandatory TRANSFER_PARTY X(1) 

 Sequence 
Number 

SEQ_NO Sequence number indicating the party number. 
Content value should be from 1 to 4. 

 
Same number indicated in PARTY_TYPE 

Mandatory TRANSFER_PARTY 9(1) 

 Party English 
Name 

ENG_NAME_1 Line1, Line2, Line3 of the party English name 
 

Input English characters, maximum 50 
characters allowed every line 

Mandatory to 
input either 
ENG/CHI or 
both 

TRANSFER_PARTY X(50) 
ENG_NAME_2 TRANSFER_PARTY X(50) 
ENG_NAME_3 TRANSFER_PARTY X(50) 

 Party Chinese 
Name 

CHIN_NAME Party Chinese name 

Input Chinese characters. 

For an individual, maximum 6 characters 
allowed. 

 
For an organization, maximum 50 characters 
allowed. 

TRANSFER_PARTY X(50) 

 HK Identity 
Card Number 

PRN HKIC Number - for individual with Hong Kong 
identity card 

 
For A123456(7), input as A1234567. 

Mandatory to 
input either 
PRN, 
PASSPORT_ 
NO, BRN or 
OTHER_ 
COMPANY_ 
NO 

TRANSFER_PARTY X(9) 

 Passport 
Number 

PASSPORT_NO Passport Number - for individual without Hong 
Kong identity card 

 
Input alphanumeric characters 

TRANSFER_PARTY X(30) 

 Business 
Registration 
Number 

BRN Business registration number 
 

Input numbers 

TRANSFER_PARTY 9(8) 
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Group Name Element Name Description Data Rules for 

upload 
Repeat Group Format 

 Other Company 
Number 

OTHER_COMPANY_ 
NO 

Other company number 
 

Input alphanumeric characters 

 TRANSFER_PARTY X(30) 

 Correspondence 
Address 

ENG_CORR_ADDR_1 For English correspondence address, maximum 
30 characters allowed every line. 

 
For Chinese correspondence address, maximum 
20 Chinese characters allowed every line. (Only 
line 1 to 3 is allowed.) 

Mandatory TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_2  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_3  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_4  TRANSFER_PARTY X(30) 
ENG_CORR_ADDR_5  TRANSFER_PARTY X(30) 
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